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Chapter 1. Before you Begin

In this chapter:

√√  What is Movex Explorer

√√  Target group and prerequisites

√√  Related documents

√√  How this manual is organized

√√  Conventions used in this manual

1.1 What is Move x Explorer
Movex Explorer is the new user interface for Movex. Historically, Movex has had
a character based AS/400 user interface (also known as 5250). This user interface
is based on a command-driven user interaction.

Movex Explorer brings together the benefits of the well-proven 5250 interface
with the commonly used MS Windows standards. As a result, the use of widely
accepted features such as drop-down menus, toolbars, shortcut menus, command
buttons, check boxes and Gantt charts, provide the user interface with better
overview, consistency and customization capabilities.

Movex Explorer is developed using MS Developer Studio, MS Visual C++ and
MS Foundation Classes (MFC) in accordance to MS Design Guidelines. The
visual structure is based on the same principles as Windows Explorer, that is, the
application is divided into a navigation (Navigator) and workspace (Workspace)
area. The Navigator contains Movex programs, processes and links to third party
products. The Workspace hosts Movex panels and launched third party products.
It can also be used as an ordinary Internet browser.

Besides running Movex programs, Movex Explorer supports integration with third
party products through OLE/ActiveX support and a COM interface.

1.2 Target Group
This manual is intended for end users and consultants working with Movex.
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1.3 Prerequisites
This manual is a complete guide to how Movex Explorer is structured and is
designed to help you gain full control of the user interface.

To get the most out of this manual you need:

• basic Movex knowledge

• basic knowledge of Windows 95, Windows 98 or Windows NT. For common
Windows commands, see the appropriate documentation.

1.4 How This Manual is Organized
The charts below show in which chapter or appendix you find a specific topic:

Chapter Topic

Chapter 1. Before you Begin Introduction to Movex Explorer. It
is essential that you read this
chapter before going any further. It
contains typographical conventions
and some tips on how to do certain
things in a quicker way.

Chapter 2. Getting Acquainted with
Movex Explorer

Contains the basics of Movex
Explorer.

Chapter 3. The Navigator Description of how to use the
Navigator.

Chapter 4. The Workspace Description of how to use the
Workspace.

Chapter 5. Menus in the Menu Bar Describes the menus in the menu
bar. This chapter should be used as
a reference book.

Chapter 6. Shortcut Keys Contains all the shortcut keys in
Movex Explorer.

Chapter 7. Running Movex Programs Provides information about the
different ways of handling
information in the Workspace once
you have started a program.



Chapter 1. Before you Begin

3

Appendix Topic

Appendix A – Document Links Provides information about document
links in Movex Explorer.

Appendix B – List View Icons Provides information about list view
icons in Movex Explorer.

Appendix C – Troubleshooting Provides information about how to solve
potential problems.

Appendix D – Toolbar Buttons in
Movex Explorer

Describes the buttons available on the
five standard toolbars in Movex Explorer.

Appendix E – Menu Command
Shortcuts

Lists the available menu command
shortcuts.

Appendix F – Glossary Explains certain words used in this
manual.

1.5 Related Docu ments
For information about installation and setup of Movex Explorer, see Movex
Version 10 & 11 Reference Manual - Movex Explorer Installation and
Environment Setup (rmbexie1.doc). This manual is included in the Movex
Explorer CD delivered from Intentia R&D.

1.6 Conventions  Used in This Manual
In this manual we have made use of the guidelines in Microsoft Manual of Style
for Technical Publications (Second Edition). The commands, menu names,
references etc, are presented in the following way in this manual:

• References to chapters and other manuals are written in Italics.
Example: See Chapter 2.1 Start and Exit Movex Explorer.

• Titles of windows, dialog boxes, tabs, menus, commands, folders, buttons,
toolbars and fields are printed in bold type. The first letter is capitalized to
distinguish the names from regular text.
Example: The Movex Explorer Properties dialog box appears.

• Shortcut keys are printed in bold type. If joined with a plus sign (+), for
example Ctrl+X, press and hold the first key while pressing the remaining
key(s).

• Commas separate a series of menu selections.
Example: Select Edit, Copy indicates that you first open the Edit menu and
then choose the command Copy.
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• Text to be entered is written in another font.
Example: Type lng<xx> where xx stands for the language code, for
example, se for Swedish.

• Each button (except for OK) is described with a picture, for example, Click

. The buttons in the table below have no visible names.

Browse

New (Insert)

Delete (Delete)

Move Up (Alt+Up Arrow)

Move Down (Alt+Down Arrow)

• The secondary mouse button is in this manual referred to as the right mouse
button.
Example: Right-click and select …

• The following headings are used to draw your attention to different types of
additional information:

Note Points out an interesting or helpful fact, or some other
comment that deserves emphasis.

5250 Note Points out the similarities or differences between Movex
Explorer and Movex 5250.

Tip A little piece of friendly advice, or a shortcut.

Important Points out information that is critical or essential to the
function of Movex Explorer.
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1.7 Tips to make  it easier for you
This manual is described from a menu point of view, but you can carry out most
commands in ways that are quicker and easier than by using the menus in the
menu bar.

To make your work as easy as possible we recommend that you get familiar with
the different ways of executing commands, using function keys, options, open
related options, check boxes, editable lists etc. You will notice that each of these
operations can be performed in many different ways. Knowledge of these will
make it possible for you as a user to optimize the way you work.

For example, when running a Movex program you will be instructed to open a
record in a list by highlighting the record and selecting File, Open. You can also:

• right-click the record and select Open in the shortcut menu that appears, see
Chapter 3.5 Shortcut Menus in the Navigator and Chapter 4.2 Shortcut Menus
in the Workspace.

• use the shortcut key Shift+F10 to reach the shortcut menu and there select
Open, see Chapter 6 Shortcut Keys.

• highlight the record and click the Open toolbar button , see Appendix D
Toolbar Buttons in Movex Explorer.

In most cases the Run command is used to start Movex programs but it can also
be used for other purposes. You can change company in the Run dialog box by
typing, for example, CMP002 (company 002, division blank) or CMP002AAA
(company 002, division AAA). The same method applies to language (LNGGB)
and planning version (VERA).
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Chapter 2. Getting Acquainted with
Movex Explorer

In this chapter:

√√  How to start and exit Movex Explorer.

√√  Information about different features in the user interface.

√√  Information about shortcut keys, function keys, dialog boxes and their elements,
commands, tools, and functions available in Movex Explorer.

2.1 Start and Exi t Movex Explorer
When Movex Explorer is properly installed on your workstation, you can start it
in the manner described below.

TO START MOVEX EXPLORER:

1. Double-click the Movex Explorer icon on your desktop or select Start, Programs,
Movex Explorer, Movex Explorer 10.B/11.2ThisGen. The Movex Logon dialog
box is displayed.

2. Type your user name the very first time you log on (after that, the system will use it
by default).

3. Type your password.

4. Select the appropriate application server the first time you log on (after that, the
system will use it by default).

5. Click OK. Movex Explorer connects to the server. (To run Movex Explorer offline,

click  instead.)
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TO EXIT MOVEX EXPLORER:

Select Movex Explorer, Exit.

Note
Before exiting Movex Explorer we recommend that you close
all open tabs. If there are tabs open when you exit, Movex
Explorer will close them for you. However, if you are in a
Movex program that has to be closed with something other
than F3, Movex Explorer will ask you to close the program
manually.

2.2 Available He lp
Reference information for certain tools and commands is available as Help (Help
Topics on the Help menu). For Movex-specific help, press F1.

2.3 Structure an d Components
Movex Explorer consists of essentially four main parts; the menu bar, toolbars, the
Navigator and the Workspace. The menu bar and toolbars are all dynamically
changed to reflect the program that has focus.

Movex Explorer contains two panes, separated by a movable split bar. The left
pane is called the Navigator; the right pane is the Workspace. The appearance is
similar to that of Windows Explorer.

Throughout Movex Explorer and all Movex programs, the use of function keys,
shortcut keys, the right mouse button, scroll bars etc have been made available.

2.3.1 The Navigator
The Navigator is where you select the program to be run. You can customize it to
provide you with the functions that you need to access. The Navigator can be
sized using the movable split bar that separates the Navigator from the
Workspace. It contains three default tabs:

• Processes – where you find your own processes (defined in the Enterprise
Process Manager tool, EPM).

• Favorites - where you define your own menu.

• Movex – where you find the Movex programs that you are authorized to use.
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2.3.2 The Workspace
The Workspace is the area where you display and process information. It is where
you run a Movex program or third party product – MS Word, for example.
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2.3.3 The Menu Bar
The menu bar appears at the top of the Movex Explorer window and has the
following appearance:

The menus are described briefly in the table below:

Menu Description

Movex Explorer The Movex Explorer menu contains settings and
actions for Movex Explorer in general.

File The File menu reflects the actions and settings
available for a Movex object.

Edit The Edit menu contains general-purpose
commands.
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View The View menu contains the Run command and
settings for the toolbar, navigation view, fonts and
Internet browser.

Insert You can use the Insert menu to open new objects,
such as Internet pages and Excel spreadsheets, on
a Workspace tab.

Tools The Tools menu contains tools for customization
and integration per user.

Help The Help menu provides access to help
information and contains the Movex Companion
help tool.

2.3.4 The Toolbars
Below the menu bar, you will find toolbars with buttons that provide quick access
to the most commonly used commands. Appendix D Toolbar Buttons in Movex
Explorer lists the toolbars and buttons.

The buttons are explained with ToolTips if you place the pointer on them, see the
picture below. This is a commonly used Windows feature.

The toolbars are context-sensitive, meaning that they will reflect the program
currently in focus, for example, if you start a web page, the Internet Explorer
toolbar will appear.
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There are five standard toolbars available in Movex Explorer:

Toolbar Description

Movex Explorer This toolbar contains buttons such
as Cut, Copy, Paste, Find, Run
and Properties.

User-defined This toolbar contains buttons that
you can define according to your
preferences.

Function This toolbar contains buttons such
as Show and Open. It is made
available when a Movex program
is active in the Workspace.

Function Key This toolbar contains the function
keys that are available for the
Movex program you are running.

Open Related This toolbar contains buttons to
call programs that are related to
the Movex program that you are
working in.

2.3.5 Shortcut Keys
When pressed, shortcut keys provide quick access to frequently performed
operations, see Chapter 6 Shortcut Keys.

2.3.6 Function Keys
Throughout Movex Explorer and all Movex programs, the use of function keys
have been made available, see Chapter 7.7 Function Keys.

5250 Note
The function keys in Movex Explorer correspond to those in
Movex 5250. But, since the function key standard differs
between the Windows and AS/400 environment, it is
sometimes necessary to let the AS/400 override Windows
when it comes to interpreting function keys. This is achieved
by using the Alt key together with the function keys. For
example: F6 in Windows changes focus between the left and
right pane. F6 in Movex 5250 means free text. For F6 to have
the same function in Movex Explorer as in 5250, you have to
use Alt+F6.
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2.3.7 Controls
In Movex Explorer you use different controls such as command buttons and check
boxes to display information in the most appropriate way and to help you carry
out a particular command or task.

The following controls appear in Movex Explorer:

Control
name

Definition Example

Check box A square box that you
select or clear to turn
on or off an option.
You can select more
than one check box.

5250 Note
In Movex 5250, 1 (yes)
and 0 (no) correspond to
the check box in Movex
Explorer.

Combo box A text box with a list
box attached.You can
either type or select
your choice.

Command
button

A rectangular button
used to initiate an
action. A command
button label ending
with an ellipsis
indicates that another
dialog box will
appear; more
information is needed
before the action can
be completed.

Label A text attached to any
option, box,
command, and so on.
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List A list containing
Movex objects.

5250 Note
In Movex 5250, the list
is often referred to as
the subfile.

List box Any type of box
containing a list of
items you can select.

Option
button (radio
button)

A round button used
to select one of a
group of mutually
exclusive options.

Tab A labeled group of
options used for many
similar kinds of
settings.

Text box A rectangular box in
which you can type
text. If the box already
contains text, you can
select that default text
or delete it and type
new text.

5250 Note
A text box is
synonymous to an Edit
field in Movex 5250.



Chapter 2. Getting Acquainted with Movex Explorer

14

2.3.8 The Status Bar
The status bar, which is a horizontal area at the bottom of the Movex Explorer
window, provides information such as:

• a description of menu alternatives in the Navigator

• hint lines when you point to a toolbar button

• a description of the function currently in focus in the menu tree

• messages from Movex
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2.3.9 Shortcut Menus
When you right-click a given object, a shortcut menu appears. This menu is
context-sensitive, that is, you can perform a number of operations related to the
object you are clicking on.

In the Navigator it is used to customize your menu tree and to start programs. In
the Workspace it is used to gain access to standard options and related options.
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Chapter 3. The Navigator

In this chapter:

√√  The behavior of the Navigator.

√√  How to navigate in menu trees.

√√  Navigator tabs.

√√  Menu trees in the Navigator.

√√  Shortcut menus in the Navigator.

3.1 Navigator Be havior
The Navigator can be set to behave in different ways depending on your
preferences as a user. The different alternatives are described in the following
table.

Navigator
Behavior

Action

To hide the
Navigator at all
times.

Select View, Navigation View to remove the check
mark.

Note
This alternative overrides the options described below.

To hide the
Navigator when
starting a Movex
program or
launching a third
party product.

Click the thumbtack in the Navigator to look like this
. When you start a Movex program or launch a third

party product the Workspace expands across the screen
and hides the Navigator. To show the Navigator again,
drag the pointer to the left-hand side of the screen.

To keep the
Navigator visible
when starting a
Movex program or
launching a third
party product.

Click the thumbtack in the Navigator to look like this
. When you start a Movex program or third party

product it appears on a Workspace tab and the
Navigator is still visible.



Chapter 3. The Navigator

17

3.2 Navigate in Menu Trees
A menu tree displays its contents as a hierarchical structure. You can navigate in
this structure by using:

• the mouse

• the arrow keys

• PageUp and PageDown

• “+” or “-“ on a folder

• Step Back  and Forward  toolbar buttons.

3.3 Navigator Ta bs
The Navigator can consist of several tabs (there are 3 default tabs; Processes,
Favorites and Movex) that you can switch between to show alternative menu
trees.

TO SWITCH TABS:

Click the desired tab or use the shortcut keys Ctrl+Tab or Ctrl+Shift+Tab to move
forward or backward between the tabs.

TO CREATE NEW TABS:

See Chapter 5.1.8 Properties, Navigator Tab.

TO HIDE TABS:

See Chapter 3.5.1 General Shortcut Menu.

3.3.1 The Processes  Tab
The contents of the Processes tab can be automatically generated with the
Enterprise Process Manager (EPM) tool, where it is possible to define business
processes and sub processes. The corresponding Movex programs and other third
party products would then have been organized into a number of folders and
functions that correspond to the defined business processes and sub processes.

Note
The Processes tab will contain the current user´s processes.
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3.3.2 The Favorites T ab
The Favorites tab is one that you can define freely. It would typically contain
those routines and programs that you need to gain access to that are outside of
Movex, for example, web pages and Office products. It can also be used as a
method to provide you with fast track execution of particular Movex functions if
you have the authority to maintain Movex menus. This means that when you start
Movex Explorer, you can gain access to everything you need, without executing
programs from the task bar or desktop of Windows-95 or Windows NT.

3.3.3 The Movex Tab
The Movex tab contains all the Movex programs.

5250 Note
The structure of the Movex tree corresponds to the traditional
functionally oriented menu of Movex 5250.

3.4 Menu Trees i n the Navigator
The menu trees in the Navigator consist of folders and functions. A folder can
contain sub folders and functions. A function is a Movex object, a program, a web
page or an OLE linked or embedded object.

Note
You can customize your menu tree(s) depending on security
and user privileges (in MNS150 Work with Users).

TO DRAG FOLDERS AND FUNCTIONS:

Select a folder or function on the desktop and drag it to a tab. You can also drag a folder
or function within a tab. In this case, the following shortcut menu is shown.

TO COPY AND PASTE FOLDERS AND FUNCTIONS:

1. Select a folder or function.

2. Select Copy or Cut.
3. Paste the folder or function within the same tab or on another tab.
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3.5 Shortcut Menus in the Navigator
This chapter describes the shortcut menus in the Navigator. They are used to
customize your menu tree and to start third party products.

3.5.1 General Shortcut Menu
The general shortcut menu for the Navigator is shown when you right-click a
Navigator tab:

The commands are described in the following table:

Command Description

Hide Hides the Navigator in the same way as the Close
button does.

Processes

Favorites

Movex

These tabs can be selected to show them or
deselected to hide them.

Properties Shows the Movex Explorer Properties dialog box
where you can customize the Navigator, see Chapter
5.1.8 Properties, Navigator Tab.
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3.5.2 Shortcut Menu  for Navigator Objects
The shortcut menu for Navigator objects can only be reached by right-clicking a
folder or function.

TO OPEN A FUNCTION:

1. Right-click the desired function.

2. Select Open.

TO OPEN A FUNCTION IN A NEW WINDOW:

1. Right-click the desired function.

2. Select Open in New Window.

QUICK VIEW

See Appendix A.7 MS Quick View.

TO CREATE A FOLDER OR FUNCTION IN A MENU TREE:

1. Right-click a folder or the top level of the tree to indicate that it will host the new
folder or function.

2. Select New, Folder or New, Function.

3. Name the folder or function. A new folder or function appears in the menu tree.

4. Set the properties according to your preferences.
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TO CUT A FOLDER OR FUNCTION FROM A MENU TREE:

1. Right-click the folder or function that you want to cut.

2. Select Cut.

TO COPY A FOLDER OR FUNCTION FROM A MENU TREE:

1. Right-click the folder or function that you want to copy (you can only copy one folder
or function at the same time).

2. Select Copy. (When you copy a folder or function, its contents will be copied along
with it.)

TO PASTE A FOLDER OR FUNCTION IN A MENU TREE:

1. Right-click the folder where you want to paste the cut or copied folder or function.

2. Select Paste.
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TO DELETE A FOLDER OR FUNCTION FROM A MENU TREE:

1. Right-click the folder or function that you want to delete.

2. Select Delete.

TO RENAME A FOLDER OR FUNCTION IN A MENU TREE:

1. Right-click the folder or function that you want to rename.

2. Select Rename.

TO CHANGE THE PROPERTIES OF A SELECTED OBJECT:

1. Right-click the folder or function for which you want to see the properties.

2. Select Properties. The Object Properties dialog box is shown.

3. Select one of the object types available. These are explained in the table below.
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Object Type Description

Movex Object TO CREATE A MOVEX OBJECT IN
YOUR MENU TREE:

1. Select the Movex Object option.

2. Name the new function in the Label box.

3. Type the Movex program name.

4. Select the program type.

5. Select the start option New Window to
start the Movex program in a new
window instead of in the Workspace.

6. Click OK.

OLE Embedded Object An embedded object will incorporate the
program in the Workspace.

TO CREATE AN OLE EMBEDDED
OBJECT:

1. Select the OLE Embedded Object
option.

2. Name the new function in the Label box.

3. Click  to locate the file of your choice
or type the entire search path to the file.

Note
The start options and OLE properties
depend on which type of object is to be
embedded.

4. Select Display rulers if you are using a
Microsoft product that requires this
option. We recommend it for MS Word
and MS Excel.

5. To only show a preview select Only
show preview.

6. To activate the object when switching
tab, select Activate object… .

7. Click OK.
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Program TO CREATE A PROGRAM IN YOUR
MENU TREE:

1. Select the Program option.

2. Name the new function in the Label box.

3. Click  to locate the program file of
your choice or type the entire search
path to the file.

4. Type parameters according to your
preferences (optional).

5. Click OK.

Web Page TO CREATE A WEB PAGE IN YOUR
MENU TREE:

Note
The following instruction assumes that you
have an Internet connection and that your
Internet browser is connected and works.

1. Select the Web Page option.

2. Name the new function in the Label box.

3. Type the address of your choice in the
Web page box.

4. Click OK.
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OLE Linked Object An OLE linked object will start the
program in which the object was created.

TO CREATE AN OLE LINKED
OBJECT:

1. Select the OLE Linked Object option.

2. Name the new function in the Label box.

3. Click  to locate the document of your
choice. The document can be placed
anywhere, for instance on a server or on
your local hard drive.

Folder TO CHANGE THE PROPERTIES OF A
FOLDER:

1. Select Folder.
2. Enter a label.

3. Click  to locate the folder on your
computer or in the network.

Note
The command to pass to MS Explorer is set
by default. It should not be changed.
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Chapter 4. The Workspace

In this chapter:

√√  Wallpaper.

√√  Shortcut menus in the Workspace.

√√  Programs open simultaneously.

4.1 Wallpaper
Besides the Movex picture (default), you can use any other bitmap picture, AVI
file or web page as wallpaper on the Workspace, see Chapter 5.1.9 Properties,
Workspace Tab.

4.2 Shortcut Menus in the Workspace
When you right-click a given object, a shortcut menu appears. This menu is
context-sensitive, that is, you can perform a number of operations related to the
object you are clicking on.

When you are running Movex in the Workspace, the shortcut menu is used to gain
access to standard options and related options. But, in other programs such as MS
Internet Explorer and MS Word, the shortcut menu will reflect the program in
focus.

4.2.1 Wallpaper Shortcut Menus
Depending on which wallpaper you choose, you get different shortcut menus
when you right-click the Workspace. If the wallpaper is a web page, the shortcut
menu is the same as in your Internet browser. If the wallpaper is the Movex
picture, the general shortcut menu is shown.
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4.2.2 General Shortcut Menu
The general shortcut menu for the Workspace is shown when you right-click a
Workspace tab.

Command Description

Insert New Object See Chapter 5.5.1 Insert New Object.

When an OLE object is inserted into
the Workspace, it will appear in read-
only mode. Double-click the object to
activate it.

Note
To be able to modify and save your object,
for example an MS Word document, you
must open it in a new window.

Open in New Window TO OPEN THE OBJECT IN A NEW
WINDOW:

1. Right-click the Workspace.

2. Select Open in New Window.

Deactivate Current OLE Object TO DEACTIVATE THE CURRENT
OLE OBJECT:

1. Right-click the Workspace.

2. Select Deactivate Current OLE
Object.
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Close Active Tab TO CLOSE THE TAB THAT IS
ACTIVE IN THE WORKSPACE:

1. Right-click the tab.

2. Select Close Active Tab.

Properties TO CUSTOMIZE THE
WORKSPACE:

1. Right-click the tab.

2. Select Properties. The Movex
Explorer Properties dialog box
appears.

3. Select the Workspace tab and see
Chapter 5.1.9 Properties, Workspace
Tab.

4.3 Several Tabs  Open
You can have several tabs open and switch between them by clicking a tab. If you
have more tabs than will fit in the Workspace, use the arrows  next to the
tabs to shift the tabs to the right and to the left.
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Chapter 5. Menus in the Menu Bar

In this chapter:

√√  The menus in the menu bar.

5.1 Movex Explo rer Menu
The Movex Explorer menu contains settings for Movex Explorer in general. The
following commands are available in this menu and are described in the sections
below.
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5.1.1 Sign off from Movex
If you are running Movex Explorer online you can disconnect from the application
server and run offline.

TO SIGN OFF FROM MOVEX:

1. Select Movex Explorer, Sign off from Movex. The Movex Explorer Offline Setup
is displayed.

2. Verify your user ID, start menu and language code.

3. Click OK. Movex Explorer disconnects from the server.
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5.1.2 Connect to Movex
If you are running Movex Explorer offline and would like to run online you can
connect to Movex in the manner described below.

TO CONNECT TO MOVEX:

1. Select Movex Explorer, Connect to Movex. The Movex Logon dialog box is
displayed.

2. Type your user name the very first time you log on (after that, the system will use it
by default).

3. Type your password.

4. Select an application server the first time you log on (after that, the system will use it
by default).

5. Click OK. Movex Explorer connects to the server.

5.1.3 Close Active T ab

TO CLOSE THE ACTIVE TAB:

Select Movex Explorer, Close Active Tab.

5.1.4 Close All Tabs

TO CLOSE ALL OPEN TABS:

Select Movex Explorer, Close All Tabs.

Note
If you are in a Movex program that has to be closed with
something other than F3, Movex Explorer will ask you to
close the program manually.
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5.1.5 New
You can create folders and functions in menu trees with Movex Explorer, New.

Note
The parameter Menu Maintenance in MNS150/F affects your
rights as a user to modify your menu trees.

TO CREATE A FOLDER:

1. Highlight the top-level or folder to which you want to add a new folder.

2. Select Movex Explorer, New, Folder.
3. Name the folder.

TO CREATE A FUNCTION:

1. Highlight the top-level or folder to which you want to add a new function.

2. Select Movex Explorer, New, Function.

3. Name the function.

5.1.6 Save Current T ree

TO SAVE THE CURRENT TREE:

1. Select Movex Explorer, Save Current Tree.

2. Name your menu tree in the Save As dialog box.

3. Click Save.

5.1.7 Print Setup
Use Movex Explorer, Print Setup to choose, for example, which printer to send
printouts to and how many copies to print.
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5.1.8 Properties, Nav igator Tab
The Navigator tab in the Movex Explorer Properties dialog box contains
settings for the Navigator.

There are three tabs defined in the standard setup of Movex Explorer: Company-
wide Processes, Customized Processes and Movex Standard Menu. You can
create new Navigator tabs and delete existing ones (except for the three standard
tabs that you can only hide). By using the check boxes, you can select (show) or
clear (hide) the tabs.

TO CREATE A NAVIGATOR TAB:

1. Select Movex Explorer, Properties and the Navigator tab.

2. Click .

3. In the Display box, type a describing name for the tab.

4. In the Title box, type the title to be displayed on the tab.

5. To select a file name, click  and locate the menu file of your choice.

6. In the Movex Explorer Properties dialog box, click OK.
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TO DELETE A NAVIGATOR TAB:

1. Select Movex Explorer, Properties and the Navigator tab.

2. Highlight the tab to be deleted and click .

3. To delete, confirm with .

4. In the Movex Explorer Properties dialog box, click OK.

TO CHANGE A TAB HEADING:

1. Select Movex Explorer, Properties and the Navigator tab.

2. Click .

3. Select the tab for which you want to change the heading.

4. Change the heading.

5. Click OK.

6. In the Movex Explorer Properties dialog box, click OK.

TO RESET THE ORIGINAL HEADING FOR THE TAB:

1. Select Movex Explorer, Properties and the Navigator tab.

2. Click .

3. Select the tab for which you want to reset the heading.

4. Click .

5. Click OK.

6. In the Movex Explorer Properties dialog box, click OK.

TO INTEGRATE THE PROCESSES MENU TREE WITH EPM:

Note
This integration will only be possible if the EPM is installed
and configured properly.

1. Select Movex Explorer, Properties and the Navigator tab.

2. Select the Integrate Process Menu with EPM check box. The Processes menu tree
will then contain the processes created with the EPM tool.
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5.1.9 Properties, Wo rkspace Tab
The Workspace tab in the Movex Explorer Properties dialog box contains
general settings, wallpaper settings and the possibility to activate custom objects
at startup.

TO CHANGE THE GENERAL SETTINGS FOR THE WORKSPACE:

1. Select Movex Explorer, Properties and the Workspace tab.

2. Select the alternatives that you want. The general settings are explained in the table
below.
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General Settings Description

Always ask for
confirmation before
closing Movex.

A dialog box is displayed where you click  if

you want to exit Movex Explorer and  if you
want to return to Movex Explorer.

Start all Movex
programs in a new
window.

All functions will start in a new window. This
option overrides all settings for Movex functions in
all menu trees.

Show messages from
server in dialog box.

Messages from the server will be displayed in a
dialog box instead of in the Status Bar.

Note
Clicking  or pressing Enter only closes the
dialog box displaying the message. If you are confirming

a message you must click  or press Enter
again.

Use Alt with F1-F24. To ensure access to all Movex function keys, this
option should always be selected.

5250 Note
Because the function key standard differs between the
Windows and AS/400 environment, it is sometimes
necessary to let the AS/400 override Windows when it
comes to interpreting function keys. This is achieved by
using the Alt key together with the function keys. For
example: F6 in Windows changes focus between the left
and right pane. F6 in Movex 5250 means free text. For
F6 to have the same function in Movex Explorer as in
5250, you have to use Alt+F6.

Use the + key as tab
key.

The “+” key on the numeric keypad will have the
same functionality as the Tab key. This feature is
useful, for example, when making fast order entry
(full screen) in OIS101.

Use grid lines in the
list view.

Each column and row in the list view will have a
borderline.

Do not start as web
page in Run dialog
box.

If a command can not be started as a Movex
function, it will not be started as a web page.

Place the cursor at the
end of the entry fields

The cursor will be positioned at the end of the entry
fields instead of the contents of the entry fields
being selected.
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TO SELECT YOUR OWN WALLPAPER:

1. Select Movex Explorer, Properties and the Workspace tab.

2. Clear the Movex picture check box.

3. Click  and select a picture, an AVI file (video sequence) or a web page.

4. If your wallpaper is an object that needs to be activated, for example an AVI file,
select the Activate This Object at Start check box.

5. Click OK.

TO SELECT THE MOVEX PICTURE AS WALLPAPER:

1. Select Movex Explorer, Properties and the Workspace tab.

2. Select the Movex picture check box.

3. Click OK.

5.1.10 Properties, Co mpany Tab
The Company tab in the Movex Explorer Properties dialog box:

• lists the available companies in your environment and shows in which
company and division you are currently working.

• lists the available languages in your system and shows in which language you
are running Movex.

• shows the current requirement version and library list information
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TO CHANGE COMPANY:

Note
To change company you must be authorized to work in
several companies.

1. Select Movex Explorer, Properties and the Company tab.

2. Click the "+" next to the company you want to change to (to expand it) and select the
required

3. division within the company.

4. Click OK.

5. Click  to confirm your selection.

Tip
You can change company in the Run dialog box by typing,
for example, CMP002 (company 002, division blank) or
CMP002AAA (company 002, division AAA).

5.1.10.1 Languages
It is possible to run Movex Explorer in more than 30 different languages including
Arabic and Japanese. The language in the system is handled through a language
library. The more language libraries you install, the more languages you will be
able to use.

Running a system in a certain language means that all the lead texts, headings and
information messages are displayed in the language of your choice. The default
language is defined in your user profile.

Note
This setting is personal and does not affect any other user in
the system.

TO CHANGE THE LANGUAGE:

1. Select Movex Explorer, Properties and the Company tab.

2. Select the language you want to change to and click OK.

3. Confirm with .

Tip
You can change the language in the Run dialog box by
typing, for example, LNGDE (German).
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5.1.10.2 Requirement Vers ion

TO CHANGE REQUIREMENT VERSION:

1. Select Movex Explorer, Properties and the Company tab.

2. Select the requirement version that you want in the Req version list.
3. Click OK.

Tip
You can change the requirement version in the Run dialog
box by typing, for example, VERA (version A).

5.1.10.3 Library List
The Current Libraries in Search Path list is automatically set when you log on

to Movex Explorer. You can view the list by pressing . The
contents in the list depend on your Movex user library list.

Important
We do not recommend that you change these settings.

5.1.11 Exit

TO EXIT MOVEX EXPLORER:

Select Movex Explorer, Exit.

5.2 File Menu
The File menu reflects the actions and settings available for a Movex object. The
following commands are available in this menu and are described in the sections
below.
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5.2.1 Open
Open is used to change a selected object.

5250 Note
File, Open corresponds to option 2=Change in Movex 5250.

TO OPEN A RECORD IN A LIST:

1. Highlight the record you want to modify, for example, an item in MMS001.

2. Select File, Open.

Note
If in an A-panel, type 2 (Open) in the Option field, a key
value and press Enter.

5.2.2 Show
Show is used to display information about a selected object.

5250 Note
File, Show corresponds to option 5=Display in Movex 5250.

TO SHOW A RECORD IN A LIST:

1. Highlight the record you want to view.

2. Select File, Show.

Note
If in an A-panel, type 5 (Show) in the Option field, a key
value and press Enter.

5.2.3 Open Related

5250 Note
The Open Related options correspond to the program unique
options in Movex 5250.

TO OPEN A RELATED PROGRAM:

1. Highlight the record for which you want to open a related program.

2. Select File, Open Related and the program of your choice.
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5.2.4 Function
File, Function contains the function keys that can be used in the current view.
Apart from the standard function keys, see Chapter 7.7 Function Keys, a Movex
program can contain a unique set of functions.

5.2.5 Documents
See Appendix A Document Links.

5.2.6 List View Icons
See Appendix B.5 Connect Icons to List View Records.

5.2.7 Select
Select is used to select an object.

5250 Note
File, Select corresponds to option 1=Crt/Select in Movex
5250.

TO SELECT A RECORD IN A LIST:

1. Highlight the record you want to select - a journal voucher in GLS100, for example.

2. Select File, Select.

5.2.8 New
New is used to create an object.

5250 Note
File, New corresponds to option 1=Crt/Select in Movex
5250.

TO CREATE A RECORD:

1. Type the key value(s) needed in the positioning (key) field(s).

2. Select File, New.



Chapter 5. Menus in the Menu Bar

42

5.2.9 Duplicate
Duplicate is used to copy a selected object.

5250 Note
File, Duplicate corresponds to option 3=Copy in Movex
5250.

TO COPY A RECORD IN A LIST:

1. Select the record you want to copy.

2. Select File, Duplicate.

Note
If in the A-panel, type 3 (Copy) in the Option field, a key
value and press Enter.

5.2.10 Delete
Delete is used to delete a selected object.

5250 Note
File, Delete corresponds to option 4=Delete in Movex 5250.

TO DELETE A RECORD FROM A LIST:

1. Select the record you want to delete.

2. Select File, Delete.

Note
If in the A-panel, type 4 (Delete) in the Option field, a key
value and press Enter.

5.2.11 Refresh
Refresh updates the information on the screen with up-to-date information from
the database.
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5.2.12 Free Text
Free Text is used to create or display text connected to an object.
When free text is available, the Free Text icon can have the following
appearances:

 No text written.

 Text written.

5.3 Edit Menu
The Edit menu contains general-purpose commands such as Cut, Copy and
Paste. The Find command contains a basic search function.

The following commands are available in the Edit menu and they are described in
the sections below.

5.3.1 Cut

TO CUT A FOLDER OR FUNCTION IN THE NAVIGATOR TO THE
CLIPBOARD:

1. Highlight the folder or function to be cut.

2. Select Edit, Cut. The folder or function is moved to the clipboard.

5.3.2 Copy

TO COPY A FOLDER OR FUNCTION IN THE NAVIGATOR TO THE
CLIPBOARD:

1. Highlight the folder or function to be copied.

2. Select Edit, Copy. The copy of the folder or function is moved to the clipboard.
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5.3.3 Paste

TO PASTE A FOLDER OR FUNCTION FROM THE CLIPBOARD INTO THE
NAVIGATOR:

1. Highlight the folder in which you want to paste the contents of the clipboard.

2. Select Edit, Paste. The folder or function is placed in the selected folder.

5.3.4 Delete

TO DELETE A FOLDER OR FUNCTION IN THE NAVIGATOR:

1. Highlight the folder or function that you want to delete.

2. Select Edit, Delete. The folder or function is deleted.

5.3.5 Find
With this command you can search through the current Navigator menu. The
search is carried out from the current selection in the Navigator and downwards.
The Find box contains all the search strings for the current session.

TO SEARCH THROUGH THE CURRENT NAVIGATOR MENU:

1. Highlight the spot from which you want to start searching.

2. Select Edit, Find. The Find dialog box appears.

3. Type the information you want to find, paste it from the Clipboard, or click a recent
entry from the list in the Find box. The search criteria can either be the description
shown in the Navigator or the actual object name (Movex program name, document
name and so on).

4. Select Match Whole Word Only if you want to find occurrences that are whole
words and not part of a larger word.

5. Select Match Case if you want to find only those instances in which the capitalization
matches the text you typed in the Find box.

6. Click  to find and select the next occurrence of the text specified in the
Find box.

7. Click  when you have finished searching.
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5.3.6 Links
This command contains information about all open OLE linked objects.

TO VIEW ALL OPEN LINKS:

1. Select Edit Links. The Links window is shown.

2. The table below shows different ways in which to use this function.

Select a link and click  to
refresh the information displayed in the
window.

Select a link and click  to open
the selected source file.

Select a link and click  to link
to another source file.

Select a link and click  to break
the connection to the link.

Select a link and change the update method.
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5.3.7 Object
The Object command is reserved for OLE applications. When there is an OLE
object in the Workspace, the Object command will change to display the options
available for that particular OLE object, see the examples in the table below.

No OLE object in the
Workspace.

OLE object (Word document) in
the Workspace.

5.4 View Menu
The View menu contains the Run command and settings for the toolbar,
Navigation view, fonts and Internet browser.

The following commands are available in the View menu and are described in the
sections below.
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5.4.1 Toolbar

TO SHOW OR HIDE A TOOLBAR:

1. Select View, Toolbar.
2. Click the toolbar you want to show or hide.

In this example the User-defined toolbar is deactivated and will not be shown.

5.4.2 Navigation View

TO HIDE THE NAVIGATOR ALL THE TIME:

Select View, Navigation View (deletes the check mark).

5.4.3 Run
With the Run command you can:

• start Movex programs (by program name)

• launch web pages (by internet address)

• change language

• change company and division

• change MRP version

• explore your computer/network.

If the command can not be started as a Movex function, it will be started as a web
page (depending on your settings in the Movex Explorer Properties dialog box).

The Run dialog box keeps track of the commands carried out depending on the
size of your command history, even in between sessions or until you clear the
history list. The latest run command is always displayed first in the stack.

To keep the Run dialog box on top and visible, select Always visible in the Run
dialog box.
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TO START A MOVEX PROGRAM:

1. Select View, Run (or press Ctrl+R).

2. Type the Movex program name or select one from the list in the Command box.

3. Select New Window if you want the program to start in a separate window.

4. Click  to execute the command (or press Enter).

TO LAUNCH A WEB PAGE:

1. Select View, Run (or press Ctrl+R).

2. Type the Internet address or select one from the list in the Command box.

3. Select New Window if you want the function to start in a separate window.

4. Click  to execute the command (or press Enter).

TO CHANGE LANGUAGE:

1. Select View, Run (or press Ctrl+R).

2. Type lng<xx> where xx stands for the language code, for example, se for Swedish.

3. Click  to execute the command (or press Enter).
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TO CHANGE COMPANY AND DIVISION:

1. Select View, Run (or press Ctrl+R).

2. Type <cmp><div> where cmp stands for company and div for division, for example,
cmp001abc.

3. Click  to execute the command (or press Enter).

TO CHANGE MRP VERSION:

1. Select View, Run (or press Ctrl+R).

2. Type the MRP version, for example, vera.

3. Click  to execute the command (or press Enter).

TO EXPLORE YOUR COMPUTER/NETWORK:

1. Select View, Run (or press Ctrl+R).

2. Type a path, for example, c:\temp.

3. Click  to execute the command (or press Enter).
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5.4.4 Fonts
You can change the font and font size for different parts of Movex Explorer.

Note
The font size will affect how the window is displayed. If you
use a large font, for example, for the Navigator tabs, they will
require much more space on the screen and you will have to
increase the Navigator to avoid scrolling.

TO CHANGE OR RESET A FONT:

1. Select View, Fonts. The different fonts used in Movex Explorer are displayed.

2. Click  and select the font you wish to use or click  to reset the
default font (which for Movex Explorer is MS Sans Serif, 9 p).
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5.4.5 Internet Browser
You can change the font size on the current web page from Largest through to
Smallest.

Note
Movex Explorer will not save your setting. Medium will be
used by default when you start a web page and you will have
to size them each time separately.

TO CHANGE FONT SIZE IN THE CURRENT WEB PAGE:

1. Open a web page.

2. Select View, Internet Browser.
3. Choose size.

5.5 Insert Menu
You can use the Insert menu to open new objects, such as Internet pages and
Excel spreadsheets, on a Workspace tab. The following command is available in
this menu and is described in the section below.

5.5.1 Insert New Object
You can run OLE documents in the Workspace without having to add them to the
Navigator.

TO INSERT A NEW OBJECT:

1. Select Insert, Insert New Object.
2. Select Create New (inserts a new object) or Create from File (inserts the contents of

the file as an object so that you can activate it using the program which created it).

3. If you select Create New, you must select which object type to insert.

4. If you select Create from File, you must select the file, for example, using .

5. Select Link to set the current object to be a linked object; if this is not set it will be an
embedded object.

6. Select Display as Icon if you want to display an icon in the Workspace.
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5.6 Tools Menu
The Tools menu contains tools for customization and integration per user.
The following commands are available in this menu and are described in the
sections below.

5.6.1 AS/400 Operat ions Navigator
This command starts the AS/400 Operations Navigator (IBM). The Movex
Explorer installation program does not install the AS/400 Operations Navigator.

5.6.2 Customize Too lbars, Properties Tab
The settings on the Properties tab are general and concern all the toolbars.

TO SHOW TOOLTIPS:

1. Select Tools, Customize Toolbars and the Properties tab.

2. Select the Show tooltips check box.



Chapter 5. Menus in the Menu Bar

53

TO CHANGE THE APPEARANCE OF THE TOOLBARS:

1. Select Tools, Customize Toolbars and the Properties tab.

2. Select the Cool look check box to give the toolbars the following appearance.

3. Clear the Cool look check box to give the toolbars the following appearance.

5.6.3 Customize Too lbars, Icons Tab
You can customize the User-defined toolbar to access frequently used functions
with buttons in the toolbar.

TO ADD A BUTTON TO THE USER-DEFINED TOOLBAR:

1. Select Tools, Customize Toolbars and the Icons tab.

2. Select one of the categories.

3. Drag a button to the User-defined toolbar. (Three buttons are default in the toolbar.)

4. Click OK.

TO DELETE A BUTTON FROM THE USER-DEFINED TOOLBAR:

1. Select Tools, Customize Toolbars and the Icons tab.

2. Drag a button from the User-defined toolbar.

3. Click OK.
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5.6.4 Customize Too lbars, Command Mapping Tab

TO MAP A BUTTON ON THE USER-DEFINED TOOLBAR:

1. Select Tools, Customize Toolbars and the Command Mapping tab.

2. Select the button on the toolbar.

3. Select Navigator Command or Menu Option.

4. If you select Navigator Command, you must click  and set the
properties in the Object Properties dialog box, see Chapter 3.5.2 Shortcut Menu for
Navigator Objects.

If you select Menu Option, you select which command you want the button to

represent and then click .

5. Click OK.
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5.6.5 Define List View Default Action
When you double-click or press Enter in a list, the default action is Open. The
default action is marked with a dot. For example:

Note
If the program is active while you change the default action,
the change will take effect the next time you start the
program.

If you want another action to be performed, you can define this per program. In
this example, the deafult action has been changed to Select.

Note
These settings are unique for each user and are stored in
…\…\Users\<user name> in your Movex Explorer installation.
Each user folder contains a file called CustDefAct.dat. If
several users are to share the same settings, you can copy
this file.
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TO DEFINE THE LIST VIEW DEFAULT ACTION:

1. Select Tools, Define List View Default Action.

2. Select New.

3. Enter the program name and select the action to be performed.

4. Click OK

5. Click .

TO CHANGE A LIST VIEW DEFAULT ACTION:

1. Select Tools, Define List View Default Action.

2. Select a default action.

3. Click .

4. Select the action to be performed.

5. Click OK.

6. Click .
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TO DELETE A LIST VIEW DEFAULT ACTION:

1. Select Tools, Define List View Default Action.

2. Select a default action.

3. Click .

4. Click .

5. Click .

5.6.6 Document Connector
See Appendix A.3 Create Document Links.

5.6.7 Icon Connecto r
See Appendix B 4 Connect Icons to a Category.

5.7 Help Menu
The Help menu provides access to help information and contains a link to the
Movex Companion help tool. The following commands are available in this menu
and are described in the sections below.

5.7.1 Welcome to Mo vex Explorer
Welcome to Movex Explorer offers an introduction to the new interface and an
overview of how Movex Explorer is structured. It also guides you through the
basic steps of how to use Movex Explorer.
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5.7.2 Help Topics
The Help Topics window contains an Index tab and a Find tab where you can
search for the topics you are interested in.
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5.7.3 Tip of the Day

TO SHOW TIPS:

1. Select Help, Tip of the Day.

2. Read the tips one by one by clicking Next Tip.

3. Click .

Note
You can choose whether to show the tips at startup or not by
selecting or clearing the Show Tips at Startup check box.

5.7.4 Movex Compan ion

Note
Movex Companion must be installed and properly configured
on your computer.

TO START MOVEX COMPANION:

Select Help, Movex Companion.

5.7.5 About Movex E xplorer
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The About Movex window contains the following information:

• Movex Explorer binary version (this information is useful for system
administrators)

• System information

• Copyright information

Press  to view the following information:

• User information such as Name, Company and Division, Language and menu
authorities.

• User configuration such as where the process tree, custom tree, Movex tree,
and view definitions are loaded from.
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Chapter 6. Shortcut Keys

In this chapter:

√√  General Movex Explorer shortcut keys

√√  General Navigator shortcut keys

√√  Shortcut keys when a Navigator tab has focus

√√  General Workspace shortcut keys

√√  Workspace list shortcut keys.

When pressed, shortcut keys provide quick access to frequently performed
operations. With the following shortcut keys, you can navigate in Movex Explorer
by only using the keyboard:

Note
Some of these shortcut keys only work if you are running
Movex Explorer in English.

6.1 Movex Explo rer
Action Shortcut Key

Change focus between the Navigator and the
Workspace

F6

Display System menu Alt Space

Edit menu Alt E

Exit Movex Explorer Alt M E
Alt Space C

Alt+F4

File menu Alt F

Help menu Alt H

Insert menu Alt I

Maximize window Alt Space X
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Minimize window Alt Space N

Move window Alt Space M

Movex Explorer menu Alt M

Movex Explorer Properties Alt M P

Restore window Alt Space R

Run Ctrl+R

Select and clear check box Space

Size window Alt Space S

Tools menu Alt T

View menu Alt V

6.2 Navigator Ge neral
Action Shortcut Key

Carry out current function Enter

Change focus between the tab and the tab
window

Tab

Copy Ctrl+C

Create a new Folder Alt M N F

Create a new Function Alt M N U

Cut Ctrl+X

Delete current function Delete

Display Object Properties dialog box for
current function

Alt+Enter

Find Ctrl+F

Next Navigator tab Ctrl+Tab

Paste Ctrl+V

Previous Navigator tab Ctrl+Shift+Tab
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6.3 Navigator Ta bs (focus on the tab)
Action Shortcut Key

Hide Navigator Shift+F10 H

Hide Processes/Favorites/Movex tab Shift+F10 DownArrow Space

Movex Explorer Properties Shift+F10 P

Next Navigator tab RightArrow

Previous Navigator tab LeftArrow

6.4 Workspace G eneral
Action Shortcut Key

Browse (if Use Alt with F1-F24 is set in the
Movex Explorer Properties dialog box,
Workspace tab)

Alt+F4

Default action Enter (in List)

Display menu containing available function
keys

Alt+F U

Finish F3

Help F1

Next Enter / Alt+RightArrow

Next Workspace tab Ctrl+Tab

Previous F12 / Alt+LeftArrow

Previous Workspace tab Ctrl+Shift+Tab

Refresh F5

Shortcut menu for current Shift+F10

Show the Navigator when hidden F6

Text function (if Use Alt with F1-F24 is set
in the Movex Explorer Properties dialog
box, Workspace tab)

Alt+F6
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6.5 Workspace L ist
Action Shortcut Key

Copy to clipboard Shift+F10 B

Default action Enter

Delete Delete
Backspace
Alt F T
Shift+F10 T

Display Open Related Alt+F R
Shift+F10 R

Document Connections Alt+F C
Shift+F10 C

Duplicate Alt F D
Shift+F10 D

Go to first record in list Home

Go to last record in list and read another set
from the database.

End

Include next row in selection Shift+DownArrow

Include previous row in selection Shift+UpArrow

Include row in focus in selection (to get a
split selection)

Ctrl+DownArrow followed by
Space
Ctrl+UpArrow followed by
Space

Keep selection and move focus one row
down

Ctrl+DownArrow

Keep selection and move focus one row up Ctrl+UpArrow

List view icons Alt+F L
Shift+F10 L

New Alt F N
Shift+F10 N

Open Alt F O
Shift+F10 O
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Open cell in editable list F2

Scroll one page down PageDown

Scroll one page up PageUp

Select Alt F E
Shift+F10 E

Show Alt F S
Shift+F10 S
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Chapter 7. Running Movex Programs

In this chapter:

√√  Introduction

√√  Basic operations in Movex

√√  Panel types

√√  Working with list views and detail views

√√  Password protected fields

√√  Editable lists

√√  Function keys and user-defined function keys

7.1 Introduction
This chapter provides you with different ways of handling information in the
Workspace once you have started a Movex program. You will, for example, learn
about list views, detail views and how to use options and function keys.

A typical workflow is described below:

Start a Movex program from the Navigator or use the Run command. The program is
opened in a Workspace tab or in a separate window. In most of the entry programs, a list
view is displayed. From the list view, you can go to the detail view or jump to a related
program.

7.2 Basic Operat ions in Movex Programs
This section describes the operations that apply to Movex programs in general.
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7.2.1 Start a Program
You can start a Movex program from the Navigator or use the Run command.

TO START A MOVEX PROGRAM FROM THE NAVIGATOR:

Double-click a program in a menu tree.

TO START A MOVEX PROGRAM USING THE RUN COMMAND:

1. Select View, Run (or press Ctrl+R).

2. Type the program name of the Movex function or select one from the list in the
Command box.

3. Select New Window if you want the function to start in a separate window.

4. Click  to execute the command (or press Enter).
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7.2.2 Finish a Program

TO FINISH A PROGRAM:

Click . Finishing a program also closes the tab.

Note
Some programs must be ended using other function keys, for
example, F12 (Cancel).

7.2.3 Switch Between Programs
When several programs are open, you can switch between the tabs by clicking the
desired tab or use the shortcut keys Ctrl+Tab or Ctrl+Shift+Tab to move
forward or backward between the tabs.

7.2.4 Navigate Betw een Panels
To navigate between Movex panels a few general-purpose commands are
available. You can either click the command buttons in a Movex panel or press
the buttons on your keyboard. The following command buttons are available:

•  is used to return to the previous panel without updating the
Movex database.

•  is used to continue to the next panel in the panel sequence,
updating the Movex database in the process.

•  is used to finish a program and return to the previous
program.

5250 Note
Previous corresponds to F12=Cancel in Movex 5250.

Next corresponds to Enter in Movex 5250.

Finish corresponds to F3=End in Movex 5250.
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7.2.5 Move Between  Controls
When in a Movex panel, you can move between controls (entry fields, combo
boxes, check boxes and lists) with the Tab key or the mouse (position and click).
When you press Tab you move forward and when you press Shift+Tab you move
back.

Tip
If you regularly use the numeric keypad to, for example, enter
invoices, we recommend the Use the + key as tab key
feature to minimize movements over the keyboard. This
setting is available in the Movex Explorer Properties dialog
box, Workspace Tab.

7.2.6 Combo Boxes

TO CHANGE THE VALUE IN A COMBO BOX:

1. Set focus on the combo box.

2. Press DownArrow to select the next value or UpArrow to select the previous value.

Note
The Inquiry Type box has a special feature, see Chapter
7.4.2 Information Views.

7.2.7 Check Boxes

TO SELECT OR CLEAR A CHECK BOX

1. Set focus on the check box.

2. Press Space to select or clear the check box.

7.2.8 Display and Confirm Messages
You can choose to display messages from the server in a dialog box or in the
status bar, see Chapter 5.1.9 Properties, Workspace Tab.

When displaying messages in the status bar, you confirm a message by pressing
Enter.

When displaying messages in a dialog box, clicking  or pressing
Enter only closes the dialog box displaying the message. If you want to confirm a

message you must click  or press Enter again.
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7.2.9 The Browse Function
You can retrieve information from the Movex database using the Browse function.
When entering a value in a field, you can also check which values are available.

TO USE THE BROWSE FUNCTION:

1. Press F4 in a browse field. The Browse window is shown.

2. You can use the Browse function in the following different ways:

• Select a value and click . The value is brought back to the browse field.

• Click  (or press F4) to display the program where the values are
maintained. You can then choose to create or fetch a record. Right-click the record
and choose Select to bring it back to the browse field.

• Click  to update the information in the Browse window from the Movex
database.

• Click  to set the following parameters:

Maximum number of records is used to check the number of selected records. The
limit is used to avoid claiming too much machine capacity, as the range is extensive
and includes a great number of records.

Date Format is used to set the date format. You can select one of the following
formats:

YMD = YYMMDD (year, month, day)
DMY = DDMMYY (day, month, year)
MDY = MMDDYY (month, day, year)
YWD = YYWWD (year, week, day of week).

• Click  to define a record interval.

• Click  to display the next available browse view.
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7.3 Panel Types
The term panel is an alternate description for different kinds of views, for
example, list and detail views. Standard panel types in Movex are listed below.

Panel Description

A Start panel intended for entering information.

B Browse panel that lists the records currently available (list view).

C Panel displayed when you duplicate a record.

D Panel displayed when you confirm deletion of a record.

E-N Panels where you enter and show detailed information (detail view).

O Panel used for printouts.

P Panel where you enter parameter values. These values are saved for
each user and program so that the same program can be used in
different ways.

T A text window where you can type user defined text.

U-Z Panels reserved for Intentia Partners and customer-specific
modifications.

7.4 Work with Li st Views
A list view contains a list of records that you can work with within a particular
program. For example, Work with Customers (CRS610) lists all the customers
that you are allowed to work with.

5250 Note
A list view corresponds to a B-panel in Movex 5250.

Once you have selected a record in the list, you can either begin working with the
record in the detail view(s) or jump to related Movex programs for that particular
record, see Chapter 5.2 File Menu. For example, when working with customers in
CRS610, you can jump to Work with Charges – Customer (OIS003) to view
information about a specific customer´s charges.
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7.4.1 Select Records  in Lists
When in a Movex list panel you can select several records by using only the
keyboard or by using the keyboard and mouse.

TO SELECT ADJACENT RECORDS USING THE KEYBOARD:

Press and hold Shift while selecting the records with UpArrow or DownArrow.

TO SELECT ADJACENT RECORDS USING THE KEYBOARD+MOUSE:

Press and hold Shift while selecting the first and last record in the range.

TO SELECT NON-ADJACENT RECORDS USING THE KEYBOARD:

1. Press and hold Ctrl.
2. Use UpArrow or DownArrow to move to the desired records.

3. Press Space to include the records in the selection.

Note
Space also deselects a selected record.

TO SELECT NON-ADJACENT RECORDS USING THE KEYBOARD+MOUSE:

Press and hold Ctrl while selecting the desired records with the mouse.

7.4.2 Information Views
You can specify which information to display in a list view by selecting an
information view, see the picture below.

5250 Note
The information view corresponds to Inquiry Type in Movex
5250.

TO CHANGE TO THE NEXT OR PREVIOUS INFORMATION VIEW:

1. Set focus on the combo box.

2. Press DownArrow to select the next view or UpArrow to select the previous view.
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TO CHANGE TO OPTIONAL INFORMATION VIEW:

1. Set focus on the combo box.

2. Press Alt+DownArrow to show all the available information views.

3. Select information view and press Enter.

7.4.3 Panel Sequence
You can set a panel sequence to display specific panels (detail views) in a certain
order. The panel sequence is displayed in the right-hand corner of the list view.

A panel represented by a letter is part of the current program. A panel represented
by a number is a panel in another program, and a call is therefore made to that
program.

The panel sequence may be overridden if certain information must be entered in a
specific order.

TO DEFINE A PANEL SEQUENCE:

1. Select File, Function, Parameters F13 in a list view.

2. Specify the panel sequence.

Note
The panel sequence is defined for each user and program.
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7.4.4 Positioning Fie lds
Positioning fields are used to search for certain records in a list. In the example
below the contents of the first two positioning fields determine which records are
displayed in the list.

7.4.5 Editable Lists
Some lists in Movex are editable which means that you can enter information into
them. In Movex, editable lists are sometimes referred to as matrixes.

To open a cell (one field in a record) for editing, simply click on it or press F2. To
move to the next cell, press the Tab key. To move to the previous cell, press
Shift+Tab.
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7.5 Work with De tail Views
A detail view contains detailed information about a certain list view record.

5250 Note
A detail view corresponds to an E-type panel in Movex 5250.

7.5.1 Pre- and Post-t ext
The pre- and post-text icons can have the following appearances:

 No text written.

 Pre-text written. Post-text not written.

 Pre-text not written. Post-text written.

7.5.2 Use Free Text
The Free Text function is used to create or display text connected to an object.

The toolbar button  indicates that there is text connected to the current object.

Note
In Windows NT and Windows 98 you can use both Alt+F6
and Ctrl+F6 to access the Free Text function. In Windows 95
you have to use Ctrl+F6.

Tip
If your text is structured in any way we recommend you to
choose a non-proportional free text font, for example,
Courier, in the Font Settings window, see 5.4.4 Fonts.
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TO USE THE FREE TEXT FUNCTION:

1. Press Ctrl+F6. The Text window is shown.

2. Type your text in the text block (up to 500 lines) and press .

TO USE THE TEXT BLOCK FUNCTION:

1. Press Ctrl+F6. The Text window is shown.

2. Type an identity in the Text block field.

3. Type a language code in the Language field. It specifies in which language external
documents are printed.

4. Select whether the text should be internal, external or both.

5. Type a description in the Name field.

6. Type your text in the text block (up to 500 lines).

7. Press .
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7.5.3 Bar Charts
Bar charts are used in certain Movex programs, for example in CPS100 (Display
Load - Totals). They can be configured in many different ways, see the examples
below.

TO CONFIGURE A BAR CHART:

1. Right-click a chart. A shortcut menu is shown.

2. Select Properties to change the appearance of the Bar chart.

TO PRINT A BAR CHART:

1. Right-click a chart. A shortcut menu is shown.

2. Select Print to print the Bar chart according to your printer settings.

TO SCROLL A BAR CHART:

Press PageUp to scroll to the left and PageDown to scroll to the right.

Note
We recommend you to use the default Bar charts to view the
information available in Movex Explorer. You can change the
appearance of a Bar chart by using the Bar chart properties.
Any changes made to the properties will be restored the next
time you start the program. The Use default property is
therefore always set when you start the program.
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7.5.4 Gantt Charts
Gantt charts are used in certain Movex programs, for example in CPS130 (Display
Gantt Chart). You can zoom in and out, print the charts and set print properties.

TO ZOOM IN:

1. Right-click the Gantt chart. A shortcut menu is shown.

2. Select Zoom In to view the Gantt chart on a higher detail level.

TO ZOOM OUT:

1. Right-click the Gantt chart. A shortcut menu is shown.

2. Select Zoom Out to view the Gantt chart on a lower detail level.

TO PRINT THE GANTT CHART:

1. Right-click the Gantt chart. A shortcut menu is shown.

2. Select Print.

TO SET THE PRINT PROPERTIES:

1. Right-click the Gantt chart. A shortcut menu is shown.

2. Select Print Properties and set the desired properties.

7.5.5 Field Control
To simplify maintenance of basic data you can specify how to display fields in a
detail view. You can create panels that only contain information of particular
interest to you and also limit access rights to read-only or edit access. These
settings are saved for each user and panel.

Field control is available for use mainly in programs for item, customer, and
supplier entry.
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TO ACCESS FIELD CONTROL:

1. Select File, Function, Field Select F13 in a detail view.

2. Specify how you want to display the fields in the detail view.

0 = The field is not displayed.
1 = The field is displayed but cannot be modified.
2 = The field is displayed and can be modified.

Note
To change all the settings to default (“2”), press F13.

7.6 Password Protected Fields
Some fields in Movex are password protected, meaning that when you type
characters in such a field, they are displayed as asterisks (*).

7.7 Function Keys
Movex contains a number of standard function keys with the same function
regardless of where they are used.

When you have focus on the Workspace, you will find most of the function keys
in the File menu, under the command Function. F5 and F6 are found at the
bottom of the File menu.

Since the function key standard differs between the Windows and AS/400
environment, it is sometimes necessary to let the AS/400 override Windows when
it comes to interpreting function keys. This is achieved by using the Alt key
together with the function keys.
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Function
Key

Description

F1 Displays help text for the current field. F1 is always available
in the Workspace.

F3 Ends a function.

F4 Displays available values for the current field.

F5 Displays refreshed information from the Movex database.

Alt+F6 (F6) Displays a text window where you can type user defined text.

Note
Applies to Windows 98 and Windows NT.

Ctrl+F6 (F6) Displays a text window where you can type user defined text.

Note
Applies to Windows 95, Windows 98 and Windows NT.

F6 Changes focus between the Navigator and the Workspace.

Shows the Navigator when hidden.

F7 Displays the previous record.

F8 Displays the next record.

F9 Displays any changes made in a field.

F12 Returns to the previous panel without saving the changes.

Alt+Shift+F1
(F13)

In a list view: Displays panel P where you enter parameter
values.

In a detail view: Displays Field Control where you can specify
how to display fields in a detail view.

F17 Displays a panel where you can select the information that
you want to view.
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7.8 User-defined  Function Keys

5250 Note
In Movex 5250 you can use Work with Function Keys
(MNS145) to add function keys to certain Movex functions. In
Movex Explorer this functionality has been incorporated in
the User-defined toolbar. This means that you can use the
User-defined toolbar to access anything that can be hosted in
the menu trees of the Navigator, for example:

• commonly used Movex programs

• menu commands within Movex Explorer

• Web addresses

• MS Office products and documents

• Lotus Notes

For more information, see Chapter 5.6.3 Customize Toolbars,
Icons Tab.
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Appendix A: Document Links
This appendix provides information about document links in Movex Explorer.

A.1 What is a Document Link
Document links allow you to gather different kinds of information related to a
Movex program record or field. This is achieved by linking so called documents
to a particular record or field in Movex Explorer. A document can be basically
any file existing on a Windows client, for example, a bitmap, an MS Word
document, an MS Excel spreadsheet or a video clip.

In the example below several documents are linked to the employee record Tina
Tiger in Work with Employees (HRS001):

• an MS Word document containing information about Tina Tiger

• a bitmap picture showing what Tina Tiger looks like

• an MS Excel spreadsheet containing Tina Tiger´s work schedule.
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A.2 How Document Links Work
To be able to use document links you first have to create a link category that is
connected to one or several fields in a Movex panel. You can then link documents
using this link category.

A link category is uniquely identified by the key field(s) connected to it. See the
examples below.

Example 1:
The link category Employee is connected to the Employee no field (in
HRS001/B1). Since each employee has a unique employee number, the
documents linked to Tina Tiger will only be available when the link category
finds 210 in the Employee no field.

Example 2:
The link category Item Group is connected to the Item Group field (in
MMS001/B5). Since several items can belong to the same item group, the
documents linked to items in item group CBF will be available when the link
category finds CBF in the Item Group field.
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A.3 Create Document Links
This section describes how you create link categories in Movex programs, that is,
provide the possibility to link documents to a specific field or combination of
fields. It also describes how you link documents using this category.

Note
Movex Explorer stores information, such as link categories,
about the latest run program to optimize the startup time.
When you have created a link category you must therefore
refresh this information by finishing the program, running any
other program and restarting the program.

TO CREATE A LINK CATEGORY IN A LIST VIEW:

1. Start the Movex program in which you want to create a link category.

2. Select Tools, Document Connector.
3. Select View in the list of available views and click OK. The fields in a list view are

usually grouped in three different formats: BC contains the control fields above the
list, BS contains the list and BF contains “footer” fields below the list.

Note
The S in the program name is changed to A in the Window
menu. This is due to the format-naming standard in Movex
Explorer.

4. In the Configure Links for Document dialog box, select a link category from the
Category box or specify a new one.
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5. Select, from the Available Fields list, the key field(s) that the link category will be
connected to. To select more than one field, press and hold Ctrl while selecting.

6. Click  to connect the key field(s) to the link category.

7. Go to step 4 to create another link category.

8. Click OK to finish.
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TO CREATE A LINK CATEGORY IN A DETAIL VIEW:

1. Start the Movex program and go to the detail view in which you want to create a link
category

2. Select Tools, Document Connector.
3. In the Configure Links for Document dialog box, select a link category from the

Category box or specify a new one.

4. Select, from the Available Fields list, the key field(s) that the link category will be
connected to. To select more than one field, press and hold Ctrl while selecting.
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5. Click  to connect the key field(s) to the link category.

6. Go to step 3 to create another link category.

7. Click OK to finish.

TO LINK A DOCUMENT TO A FIELD IN MOVEX:

1. Start the Movex program in which you want to link a document to a field or
combination of fields.

2. Select File, Document Links.

3. In the Documents window, click .

4. In the Add New Document Link window, specify the title, type and path for the

document or click  to locate the document.

Note
Make sure that all users who need the linked document can
access it. Do not link a document located on your disk if the
users who need the document can not access your disk.

5. Select a link category, that is, the field(s) to which the document will be linked.

6. Click OK. The document is now linked to the selected field(s) (link category).

7. Repeat step 3-6 if you want to link another document to the current field.

8. Click OK.
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A.4 Work With Document Links
This section describes how you open, show, print and unlink linked documents in
Movex Explorer.

TO OPEN A LINKED DOCUMENT:

1. Start the Movex program.

2. Select a record or field to which the document is linked. (In the example below, the
documents are linked to the employee number 210)

3. Select File, Documents.

4. Select the document link and click . The program associated with the
file extension is started, see Appendix A.6 Document Association.

TO SHOW A LINKED DOCUMENT:

1. Start the Movex program.

2. Select a record or field to which the document is linked.

3. Select File, Documents.

4. Select the document link and click . MS Quick View is started (if
available for the current document), see Appendix A.7 MS Quick View.
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TO PRINT A LINKED DOCUMENT:

1. Start the Movex program.

2. Select a record or field to which the document is linked.

3. Select File, Documents.

4. Select the document link and click . The printer settings in the
associated program are used.

TO UNLINK A LINKED DOCUMENT:

1. Start the Movex program.

2. Select the record or field to which the document is linked.

3. Select File, Documents.

4. Select the document link and click .

5. Press OK to confirm.

A.5 Disable a Link Category
This section describes how you disable link categories.

TO DISABLE A LINK CATEGORY:

1. Start the Movex program in which you want to disable a link category.

2. Select Tools, Document Connector.
3. Select View in the list of available views and click OK.

4. In the Selected Fields list, select the category to be disabled.

5. Click .

6. Click OK.

A.6 Document Association
When opening a document from Movex Explorer, the program associated with the
document is automatically started. The association is between the file extension
and the program. For example, when opening a document with the extension
bmp, the program MS Paint is automatically started and the document is opened.

For further information regarding Document Association, we refer to the
appropriate Windows documentation.
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A.7 MS Quick View
If a linked document is not associated with a program, Movex Explorer provides
the possibility to view the document in a program called MS Quick View.

MS Quick View is a set of file viewers supplied with MS Windows 95, MS
Windows 98 and MS Windows NT 4.0. Using MS Quick View you can view
documents that were created with Windows-based programs without starting those
programs. If Quick View is not available, either the document does not support it
or Quick View is not installed on your computer.

The example below shows a .ini file displayed using MS Quick View.

Note
Not all items are displayed in the way you expect them to be
when using Quick View. For example, when you view a
binary file such as an animated pointer file (∗.ani) using Quick
View, you see the binary contents and not a picture of the
pointer.
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A.8 Demonstration Kit
The folder DemoDocuments (installed together with Movex Explorer) contains a
number of example documents.

The table below shows which programs we recommend you to use to open the
example documents in the folder DemoDocuments.

Type Extension Program

Video clips AVI MS Media Player,
Netscape Navigator,
MS Internet Explorer.

MS Word
documents

DOC MS Word.

Pictures in
JPEG format

JPG Wang Imaging for Windows NT, Micrografx
PhotoMagic,
Netscape Navigator,
MS Internet Explorer.

AutoCad
drawings

SLD Movex AutoCad viewer (MvxAcadViewer.exe)
that can be found among the files installed
together with Movex Explorer.

Pictures in
TIFF format

TIF Wang Imaging for Windows NT,
MS Paint,
(Micrografx PhotoMagic).

Text
documents

TXT MS Notepad,
Netscape Navigator.

MS Excel
spreadsheets

XLS MS Excel.

Appendix B: List View Icons
This appendix provides information about list view icons in Movex Explorer.

B.1 What is an Icon Connection
The general idea with icon connections is to give you a better overview of the
information displayed in list views. You can visually emphasize list view records
with certain attributes by connecting icons to the records.
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The example below is a list view in Work with Items (MMS001), where records
with the same status are assigned the same icon.

Note
To be able to work with list view icons the icon database
must be installed. In a standard installation, this database is
installed automatically. In a custom installation, this database
must be manually selected for installation. Further
information about installation procedures is provided in the
manual Movex Explorer Installation and Environment Setup.
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B.2 How Icon Connections Work
To be able to connect icons to list view records, you must first specify an icon
category to identify each list view record. This is done using the development tool
Movex Visual Builder, see the manual Movex Explorer Installation and
Environment Setup. You can then, in Movex Explorer, connect icons to list view
records in all Movex programs.

An icon category is uniquely identified by the key field(s) connected to it. Icon
categories can be used in several list views. A specific icon can be used in several
icon categories.

For example:
All records with the same entry in the Status field have the same icon in the list
view in Work with Items (MMS001).

Note
If Movex Explorer is installed on a Movex Explorer file server,
the icon connections made by one user are displayed for all
users, because the files used for icon connection are
common.
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B.3 Prepare a List View for Icons
This section describes how you, in Movex Visual Builder, specify an icon
category to identify each list view record. As a result of this procedure, the list
part of the list view is moved slightly to the right to make room for the icons, see
the example below.

Original list view List view with room for icons

TO START MOVEX VISUAL BUILDER:

1. Select Start, Programs, Movex Explorer, Tools 10.B/11.2ThisGen, Visual
Builder. The Open dialog box is displayed.

2. Click  to check or change the basic settings for Movex Visual Builder.
The Settings dialog box is displayed.
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Note
The first time the program is started you must specify a Save
path. This path is normally the same as the Open path.

3. To change the path in the Open box, click  and select another directory.

4. If you are going to work with modifications, change the subdirectory in the upper Libl
Level box to one that is valid for that modification, for example, MSEAObj for the
Swedish market modifications.

Note
The default subdirectory is MvxAObj or MvxBObj.

5. Click  to insert a new path where the modified view definitions should be saved.

6. Enter the path in the new row, or click  to set the path.

7. Repeat step 5 if you want to save the modified view definitions in more than one
location.

8. Specify the subdirectory, where the view definitions should be saved, in the lower
Libl Level box.

9. Select the Language tab and if necessary change the language in which the view
definition text is displayed.

10. Click OK to return to the Open dialog box.

11. Enter the program name.

12. Click .
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TO PREPARE A LIST VIEW FOR ICONS:

1. Select the window containing the list part of the list view (B-panel) from the Window
menu. The ID of this window usually, but not always, ends with BS.

Note
The S in the program name is changed to A in the Window
menu. This is due to the format-naming standard in Movex
Explorer.

2. Select Tools, IconLinks.

3. In the Configure Links for Icon dialog box, select an icon category from the
Category box or specify a new one.

4. Select, from the Available fields list, the key field(s) that the icon category will be
connected to. To select more than one field, press and hold Ctrl while selecting.
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5. Click  to connect the field(s) to the icon category.

6. Click OK to save the icon link.

Note
If you are running the current program in Movex Explorer
while modifying the program’s view definition (or if the current
program was the last used program), the views in Movex
Explorer are not automatically changed according to the
modifications. You must first run another program in Movex
Explorer, then run the current program again. This is
necessary because the last used view definition is stored in
the cache memory to reduce the loading time.

B.4 Connect Icons to a Category
The category selected or created in Movex Visual Builder is initially empty. You
have to fill it with icons that can be connected to list view records. When
delivered from Intentia R&D, the directory \Movex Explorer
<version>\IconLinks\ListIcons contains a large number of icons. If these icons are
not suitable for the current list view, you can add new icons, see Appendix B.6
Add New Icons.

Note
A specific icon category can be used in several list views.
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TO CONNECT ICONS TO A CATEGORY:

1. Select Tools, Icon Connector to display the Connect Icons to Category dialog
box. (Depending on the number of icons in the icon database, this can take a while.)

2. Select an icon category from the Category box.

3. Select, from the Available icons list, the icons that the category will be connected to.
To select several adjacent icons, press and hold Shift while selecting the first and
last icon in the range. To select several icons that are not adjacent, press and hold
Ctrl while selecting.

4. Click  to connect the icon(s) to the category.

5. To assign a default icon to all list view records that are not connected to a specific

icon, select an icon from the Selected icons list and click . This icon will
be used in all the list views that are using the current icon category.

To assign a default icon to a specific list view record, see Appendix B.5 Connect Icons
to List View Records.

6. Click  and .

TO DELETE A SELECTED ICON FROM THE LIST

1. Select Tools, Icon Connector to display the Connect Icons to Category dialog
box.

2. Select the icon in the Selected Icons list and click .

TO DELETE ALL SELECTED ICONS FROM THE LIST

1. Select Tools, Icon Connector to display the Connect Icons to Category dialog
box.

2. Select the icons in the Selected Icons list and click .
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B.5 Connect Icons to List View Records
You can assign equal icons to records with equal values in the specified key
field(s).

TO CONNECT ICONS TO RECORDS IN A LIST VIEW:

1. Select a list view record that has the value(s) you want to assign a specific icon to.

2. Select File, List View Icons.

3. The Connect Icon to List View dialog box is displayed.

4. Select the icon you want to assign to the record, and to all other records with the
same key field value(s). Click OK.

5. Repeat step 1 to 4 for all records that have key field value(s) that should be assigned
an icon.

6. To assign a default icon to all list view records that are not connected to a specific

icon, select an icon and click . To delete a default icon from the list view,

select the icon and click .

7. Click OK.

The value(s) presented here is the
value(s) in the key field(s) for the
current record. The key field(s) is the
field(s) selected in Movex Visual
Builder for the current list view.

The icon category
selected for the
current list view.

The icons that
are connected
to the current
icon category.

The value(s) each icon
is connected to.
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TO DISCONNECT AN ICON ASSIGNED TO CERTAIN RECORDS

1. Select the list view record with the value(s) from which you want to disconnect an
icon.

2. Select File, List View Icons. The Connect Icon to List View dialog box is
displayed.

3. Select the icon to be disconnected and click .

4. Click OK.

B.6 Add New Icons
A set of icons are installed together with Movex Explorer. If you prefer other
icons, you can add any number of new icons to the icon collection located in
<Movex Explorer directory>\IconLinks\ListIcons.

The list view icons can vary between 16x16 and 64x64 pixels. Icons in size 32x32
are recommended.

A large number of tools are available for icon creation, see a few of them in
Appendix B.7 Icon Creation Tools.
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B.7 Icon Creation Tools
A large number of tools can be used to create icons. The list below contains some
of them. Some tools you have to buy, while others are shareware that you can try
for free a limited period before you have to pay for them.

Tool Description

MS Developer Studio
97 (or later version)

The graphics editor in MS Developer Studio 97 can
be used to modify graphical images, including
bitmaps, icons (16x16, 32x32, 48 x 48-pixel), and
pointers. (Used with good results at Intentia R&D.)

Axialis AX-Icons 4.0
and later versions

Icon library management tool for Windows 95 and
Windows NT 4.0. Its editor allows creation of icons
in 16x16, 32x32, 48x48, 64x64, 72x72 format and
custom sizes, using different color palettes.
Shareware, downloadable from www.axialis.com.
(Tested with good results at Intentia R&D.)

Impact Software
Microangelo 2.1 and
later versions

An integrated suite of utilities designed specifically
for icons, pointers and animated pointers. Contains
tools designed to master all aspects of these program
and desktop elements for Windows 95 and Windows
NT 4.0. Shareware, downloadable from
www.impactsoft.com.

CursorArts Company
IconForge

IconForge is used to create and modify icons or
pointers. The utility can extract icons from EXE,
DLL, ICO, ANI or CUR format files, as well as from
most common image files. Shareware, downloadable
from www.cursorarts.com
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Appendix C: Troubleshooting
This Appendix provides information about troubleshooting.

C.1 Fix Packs
As a service to our customers, Intentia R&D provide fix packs with corrections,
updates and enhanced functionality. Make sure that all available fix packs for
Movex Explorer are installed. The file FixPack.ini, located in the installation
directory, shows the fix packs currently installed.

C.2 Error Loading
If you start a Movex program and the following window appears, follow the given
instructions.

C.2 Message Monitor
The Message Monitor handles “message wait” (MSGW) from RPG programs. It
starts automatically when Movex Explorer is started. The Message Monitor is
shown as an hourglass in the taskbar and changes appearance when a “message
wait” occurs.
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C.2.1 Information Message
When  appears in the taskbar, an information message exists in the Message
Monitor.

TO VIEW THE INFORMATION MESSAGE:

1. Double-click . The Movex Explorer Message Monitor window appears.

2. Double-click in the Type column to view message details.

C.2.2 Message Wait
When  appears in the taskbar, a “message wait” exists in the Message Monitor.
The Movex Explorer Message Monitor window is shown and you can answer
the message(s).

TO DISPLAY MESSAGE HELP:

Double-click in the Type column to display detailed message help. The Message Help
Text window is shown.
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TO ANSWER A MESSAGE:

1. Right-click in the Type column to show the shortcut menu containing all valid
answers (message responses).

2. Select the appropriate answer:

C = Cancel
G = Continue processing at *GETIN
S = Obtain system dump
D = Obtain RPG formatted dump
F = Obtain full formatted dump



Appendix D: Toolbar Buttons in Movex Explorer

105

Appendix D: Toolbar Buttons in Movex
Explorer

The buttons available on the five standard toolbars in Movex Explorer are
described below. Each button has a tool tip displaying a textual description.

MOVEX EXPLORER TOOLBAR

Toolbar button Description

Save Menu Tree

Forward

Step Back

Connect to Movex

Cut

Copy

Paste

Delete

Find

Run Command

Properties

Movex Companion

About Movex
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USER-DEFINED

The User-defined toolbar contains buttons that you can define according to your
preferences.

FUNCTION

The Function toolbar contains functions available when a Movex program is
active in the Workspace. It contains standard Movex options, Refresh, Free Text
and Documents.

5250 Note
The options New, Open, Duplicate, Delete, Show, Refresh
and Free Text correspond to the options 1, 2, 3, 4, 5 and the
function keys F5 and F6 in Movex 5250.

Toolbar Button Description

New

Duplicate

Show

Open

Delete

Refresh

Free text

Documents



Appendix D: Toolbar Buttons in Movex Explorer

107

FUNCTION KEY

The Function Key toolbar contains the function keys that are available for the
Movex program you are running.

OPEN RELATED

The Open Related toolbar contains buttons to call programs that are related to the
Movex program that you are working in.
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Appendix E: Menu Command
Shortcuts

5250 Note
Most menu command shortcuts are language dependent.
This means that the shortcuts differ depending on which
language you are running Movex Explorer in.

The menu command shortcuts that apply to the standard English version are
described below. If you are running Movex Explorer in another language, you can
fill in your own shortcuts in the template provided in E.2 Language Unique
Version in Appendix E Menu Command Shortcuts.

E.1 Standard English Version

Command Shortcut
Keys

Toolbar
Button

Right-click… Double-click…

Movex Explorer,
Connect to Movex

Alt M C

Movex Explorer, Close
Active Tab

Alt M L …a Workspace
tab and select
Close Active
Tab.

Movex Explorer, Close
All Tabs

Alt M T

Movex Explorer, New,
Folder

Alt M N F

Movex Explorer, New,
Function

Alt M N U

Movex Explorer, Save
Current Tree

Alt M S

Movex Explorer, Print
Setup

Alt M R
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Movex Explorer,
Properties

Alt M P …a Navigator tab
and select
Properties.

…a Workspace
tab and select
Properties.

Movex Explorer, Exit Alt M E

Alt Space C

File, Open Alt F O …a list view
record and select
Open.

File, Show Alt F S …a list view
record and select
Show.

File, Open Related Alt F R …a list view
record and select
Open Related.

File, Function Alt F U …the panel
background in a
Workspace tab
and select
Function.

File, Documents Alt F C … the panel
background in a
Workspace tab
and select
Documents.

…a list view
record and select
Documents.

File, List View Icons Alt F L …a list view
record and select
List View Icons.

File, Select Alt F E …a list view
record and select
Select.



Appendix E: Menu Command Shortcuts

110

File, New Alt F N …a list view
record and select
New.

File, Duplicate Alt F D …a list view
record and select
Duplicate.

File, Delete Alt F T …a list view
record and select
Delete.

File, Refresh …the panel
background in a
Workspace tab
and select
Refresh.

File, Free text Alt F T …the panel
background in a
Workspace tab
and select Free
text.

Edit, Cut Alt E T …in a text box,
right-click and
select Cut.

Edit, Copy Alt E C …in a text box,
right-click and
select Copy.

Edit, Paste Alt E P …in a text box
and select Paste.

Edit, Delete Alt E D …in a text box
and press Delete.

Edit, Find Alt E F

Edit, Links Alt E K

Edit, Object Alt E O

View, Toolbar, Movex
Explorer

Alt E T M

View, Toolbar, Function Alt E T F



Appendix E: Menu Command Shortcuts

111

View, Toolbar, User-
defined

Alt E T U

View, Toolbar, Function
Key

Alt E T K

View, Toolbar, Open
Related

Alt E T O

View, Navigation View Alt E N

View, Run Alt E R

View, Fonts Alt E F

View, Internet Browser

Insert, Insert New Object Alt I I …a Workspace
tab head and
select Insert New
Object.

Tools, AS/400
Operations Navigator

Alt T O

Tools, Customize
Toolbars

Alt T C

Tools, Define List View
Default Action

Alt T L

Tools, Document
Connector

Alt T D

Tools, Icon Connector Alt T I

Help, Welcome to
Movex

Alt H W

Help, Help Topics Alt H H

Help, Tip of the Day Alt H T

Help, Movex Companion Alt H M

Help, About Movex Alt H A
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E.2 Language Unique Version
If you are running Movex Explorer in another language, you can fill in your own
shortcuts in the following template.

Command Shortcut
Keys

Toolbar
Button

Right-click… Double-click…

Movex Explorer,
Connect to Movex

Movex Explorer, Close
Active Tab

Movex Explorer, Close
All Tabs

Movex Explorer, New,
Folder

Movex Explorer, New,
Function

Movex Explorer, Save
Current Tree

Movex Explorer, Print
Setup

Movex Explorer,
Properties

Movex Explorer, Exit

File, Open

File, Show

File, Open Related

File, Function

File, Documents

File, List View Icons

File, Select
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File, New

File, Duplicate

File, Delete

File, Refresh

File, Free text

Edit, Cut

Edit, Copy

Edit, Paste

Edit, Delete

Edit, Find

Edit, Links

Edit, Object

View, Toolbar, Movex
Explorer

View, Toolbar, Function

View, Toolbar, User-
defined

View, Toolbar, Function
Key

View, Toolbar, Open
Related

View, Navigation View

View, Run

View, Fonts

View, Internet Browser
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Insert, Insert New Object

Tools, AS/400
Operations Navigator

Tools, Customize
Toolbars

Tools, Define List View
Default Action

Tools, Document
Connector

Tools, Icon Connector

Help, Welcome to
Movex

Help, Help Topics

Help, Tip of the Day

Help, Movex Companion

Help, About Movex
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Appendix F: Glossary
Arrow keys
Collective name for LEFT ARROW, RIGHT ARROW, UP ARROW and DOWN ARROW keys
on the keyboard.

Bar chart
Graph on which values are represented as vertical or horizontal bars.

Bitmap
A specific file format for online art.

Browse
To search through and access database material.

Browse field
Field where you can check which values are available.

Cache memory
Section of high-speed memory, which stores data that the computer can access quickly.

Check box
Square box that you select or clear to turn on or off an option.

Command
Word or phrase that initiates an action.

Command button
Rectangular button that initiates an action.

Control
Graphical component such as a command button or check box.

Detail view
Movex panel containing detailed information about a certain list view record.

Dialog box
Window containing command buttons and various kinds of options through which you can carry
out a particular command or task.

Document link
Link that allows you to gather different kinds of information related to a Movex program record or
field.

Editable list
List that you can enter information into.

EPM
Enterprise Process Manager tool. It is a product that manages process design and application
configuration.
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Fix pack
Fix packs contain corrections, updates and enhanced functionality.

Free text
Text connected to an object.

Function key
Key that has been assigned a particular task or sequence of instructions.

Gantt chart
Control chart especially designed to show graphically the relationship between planned
performance and actual performance.

Icon category
A key value used to uniquely identify a list view record to enable the icon connection
functionality.

Icon connection
A logical relationship between the state of any list view record and an icon symbolizing the current
state of that record.

Information view
Specifies which information to display in a list view.

Inquiry type
See Information view.

Key field
Field which identifies entries in a record.

Label
Text attached to any option, box, command, and so on.

Library list
A user unique set of search paths that defines where to retrieve the source code to Movex
functions, Movex data, constants, etc.

Link category
A key value used to uniquely identify a list view record to enable the document link functionality.
A link category is uniquely identified by the key field(s) connected to it.

List view
Movex panel containing a list of records that you can work with within a particular program.

List view icon
An icon displayed in the list view to symbolize the state of the current record.

Loading time
The time it takes to transfer a file or program from disk to memory.

Menu tree
Displays its contents as a hierarchical structure.

Movex 5250
Character based AS/400 user interface for Movex.
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Navigator
Where you select the program to be run. It contains Movex programs, processes and links to third
party products.

Offline
Movex Explorer launched without a connection to any application server.

Online
Movex Explorer launched with a connection to an application server.

Option
Choice in a dialog box.

Option button
Round button that indicates choices in a dialog box.

Pane
Refers to the two parts of a split window. The parts are called the right and left panes, respectively.

Panel sequence
A panel sequence is set to display specific panels (detail views) in a certain order.

Positioning field
Positioning fields are used to search for certain records in a list.

Radio button
See Option button.

Record
Set of items of related data.

Shareware
Software that is available free to try, but if kept the user is expected to pay a fee to the writer.

Shortcut key
Keyboard key or key combination such as CTRL+N that invokes a particular command.

Shortcut menu
A shortcut menu appears when you right-click a selection, a toolbar or a taskbar button. It lists
commands pertaining only to that screen region or selection.

Source file
Program written in source language which is then converted to machine code by a compiler.

Split bar
Vertical line that separates the Movex Explorer window into two panes.

Status bar
The area at the bottom of the Movex Explorer window that displays information about a command
or toolbar button, an operation in progress or the location of the insertion point.

Taskbar
The bar that appears by default at the bottom of the Windows 95 and later desktop.
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Text box
Box where you can type in a value.

Third party product
Software product that is not manufactured by Intentia R&D.

Toolbar
Standard term for various rows below the menu bar that contains buttons and commands for
commonly used tasks.

Toolbar button
A command button in the tool bar or status field.

Tooltip
A small pop-up window with a short descriptive text for a control or graphical element, for
example an icon or button.

Troubleshooting
Debugging computer software.

User interface
Hardware or software designed to make it easier for a user to communicate with the machine.

Wallpaper
Workspace background.

View definition
A Movex program unique file that contains information about the panels displayed.

Workspace
The Workspace is the area where you display and process information. It is the right pane of
Movex Explorer.
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Index

A

About Movex Explorer ........................................... 59
add new document link ........................................... 87
add new icons ....................................................... 100
application server.................................................... 31
AS/400 Operations Navigator................................. 52

B

Bar chart
configure ............................................................. 77
print..................................................................... 77
scroll ................................................................... 77

Bar charts ................................................................ 77
Browse function...................................................... 70
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check box ................................................................ 12
close active tab........................................................ 31
Close Active Tab .................................................... 28
close all tabs............................................................ 31
combo box .............................................................. 12
command

Hide .................................................................... 19
Run...................................................................... 47

command button ..................................................... 12
company

change ......................................................38, 47, 49
Company

Properties ............................................................ 37
confirm message ..................................................... 69
connect icons to a category..................................... 98
connect to Movex.................................................... 31
controls ................................................................... 12
Copy........................................................................ 43
Ctrl+F6...............................................................76, 80
Cut .......................................................................... 43

D

Deactivate Current OLE Object.............................. 27
Delete.................................................................42, 44
DemoDocuments .................................................... 91
demonstration kit .................................................... 91
detail view............................................................... 75
Display rulers.......................................................... 23
document association.............................................. 89
Document Connector .............................................. 57
document links........................................................ 82
Documents .............................................................. 41
Duplicate................................................................. 42

E

Edit menu............................................................ 9, 43

editable lists .............................................................74
EPM.....................................................................7, 34
error loading...........................................................102
exit Movex Explorer ................................................39

F

F1.............................................................................80
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F4.............................................................................80
F5.............................................................................80
F6.......................................................................61, 80
F7.............................................................................80
F8.............................................................................80
F9.............................................................................80
Favorites tab...................................................7, 18, 19
field control..............................................................78
File menu .............................................................9, 39
Find..........................................................................44
finish a program.......................................................68
fix packs.................................................................102
folder

change properties .................................................22
copy and paste......................................................18
copy from a menu tree .........................................21
create in a menu tree ............................................20
cut from a menu tree ............................................21
delete from a menu tree .......................................22
drag ......................................................................18
new.......................................................................32
paste in a menu tree .............................................21
rename in a menu tree..........................................22

Fonts ........................................................................50
Free Text............................................................43, 75
function

new.......................................................................32
Function ...................................................................41

toolbar................................................................106
Function Key

toolbar................................................................107
Function Key toolbar ...............................................11
function keys......................................................11, 79
Function toolbar.......................................................11

G

Gantt chart
print......................................................................78
print properties.....................................................78
zoom in ................................................................78
zoom out ..............................................................78

Gantt charts..............................................................78
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grid lines ................................................................. 36

H

Help menu......................................................7, 10, 57
Help Topics............................................................. 58
hide

Navigator ............................................................ 19
Hide command........................................................ 19

I

icon category
specify................................................................. 93

icon connections ..................................................... 91
Icon Connector........................................................ 57
icon creation tools................................................. 101
information message ............................................. 103
information view..................................................... 72
Inquiry Type ........................................................... 72
Insert menu ........................................................10, 51
Insert New Object ..............................................27, 51
Internet Browser ..................................................... 51

L

label ........................................................................ 12
language.................................................................. 38

change ......................................................38, 47, 48
launch a web page................................................... 48
link category ........................................................... 83

create in a detail view ......................................... 86
create in a list view ............................................. 84
disable ................................................................. 89

linked document
open .................................................................... 88

Links ....................................................................... 45
list ........................................................................... 13
list box .................................................................... 13
list view................................................................... 71
list view default action............................................ 55

change ................................................................. 56
define .................................................................. 56
delete................................................................... 57

list view icons ......................................................... 91
List View Icons....................................................... 41
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